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1. INTRODUCTION 

This thesis work is application of the ASDN (Agile Supply Demand Networks) 

software to improvement toy logistics network. ASDN is software for analyzing and 

developing agile logistics network. The researcher worked as a development engineer 

with ASDN software and tasks were design an example of complex toy supply demand 

networks and the content will described in the tutorial. At the same time, the each step 

calculation of ASDN tool will visualized in the text and also explains the calculate 

processing with equations. The main research aim is use ASDN software to 

improvement the toy industrial logistics network, optimize inventory value level and 

reduce lead time at the complex toy supply demand networks. 

 

1.1. Background of the study 

Nowadays the global market is more and more volatile and turbulent in manufacturing. 

The market conditions in which many companies find themselves are characterized by 

volatile and unpredictable demand (Martin, 2000), while produces high obsolete 

inventory (Christopher, 2001). Especially in toy industry, toys are extremely volatile 

and seasonal in nature (Chee, Jan & John, 2005). Volatility in the toy industry is caused 

by variable and unpredictable demands, very short and specific selling-windows and 

short product-life-cycles (Johnson, 2001). The toy industry has incurred relatively 

higher costs on obsolete inventory, lost sales and markdown as compared to other 

industries. These are the typical consequences of volatility in the toy supply chains, 

akin to the fashion clothing industry (Christopher, Lowson & Peck, 2004). So 

traditional supply chain management cannot effectively and efficiently support 

satisfying customers’ need and quickly changing market with optimize inventory level. 
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Many companies provide its customers with low cost and high quality products suitable 

in the past. Nowadays companies are striving to achieve focus on right products meet 

customers’ needs, wishes and expectations; right manufactured without difficulties and 

then easily maintained in the field (Kidd, 1994); right time with fast response to 

customers demand. From the strategic perspective, present the theory of ASCM (agile 

supply chain management) to companies becomes more important. ASCM extends 

from the customer interface at marketing and sales through production and 

procurement to the building of relationships with suppliers.  

 

Agility might therefore be defined as the ability of an organization to respond rapidly to 

changes in demand both in terms of volume and variety (Martin, 2000). If implemented 

agile supply chain management, this will provide a new dimension to competing: 

quickly introducing new customized high quality products and delivering them with 

unprecedented lead times, swift decisions and manufacturing products with high 

velocity (Dekkers & van Luttervelt, 2006; Fisher, 1997). The success of an agile supply 

chain is the speed and flexibility with which these activities can be accomplished and 

the realization that customer needs and customer satisfaction are the very reasons for 

the network (Lee & Lau, 1999). In this thesis, we address the software of ASDN (Agile 

Supply Demand Networks) which provides support to the manager in making 

improved business strategy decisions that lead to maximizing customer service and 

profits by capitalizing on the added-value of the entire supply chain (Helo, 2006).  

 

The motivation for this study is optimize the toy supply-demand networks and analyze 

the movement of products through the supply demand pipeline, monitor process, 

identify and analyze gaps, and developing process with ASDN software tool. The 

research results will resolve the toy industrial problems which are unpredictable 

demands, very short product life cycles, high costs on inventory and uncertainty of 

lead time. 
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1.2. Research problem and objectives 

Toy industry as the creative business faces many challenges, variable and unpredictable 

demands, very short product life cycles, high costs on inventory and so on. Toy sellers 

and manufactures face high levels of risk and volatility. Volatility in the toy industry is 

caused by variable and unpredictable demands, very short and specific selling-windows 

and short product-life-cycles (Johnson, 2001). Therefore, some toy manufacturers offer 

early-order or quantity discounts to push the inventory risk to the retailers. Some 

retailers use their buying power to avoid risk-taking or pass some costs to the 

manufacturers (Chee, Jan & John, 2005). Finally both sellers and manufacturers have 

same problem is high levels inventory. Traditional supply chain management studies 

have focused on removing or reducing the uncertainty within a supply chain as far as 

possible, in order to facilitate amore predicable response to change in downstream 

demand (Naylor, 2000). So it cannot effectively and efficiently support satisfying 

customers’ need and quickly changing market with optimize inventory level. 

 

With the business economy has shifted from the economics of scale towards the 

economics of scope. Toy industries face a very unique challenge, which is how to 

provide the right toys at the right quantity at the right stores during the very short selling 

windows and to frequently provide creative and yet price competitive toys (Chee, Jan & 

John, 2005). In this thesis, we will address strategy tool of agile supply chain 

management – ASDN software, which will help toy companies to fix the gap of 

inventory problem, through integrated retailers, distributors, manufacturers and 

suppliers to reduce the lead time to customers and inventory holding cost. So the 

research problem present at below: 

 

How to use ASDN software to analyze and optimize current toy industrial logistics 

network? 
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In order to resolve this research problem, there have four objectives will be discussed in 

the present study. 

 

The first objective is study agile supply chain management, demand supply chain 

management, demand response strategies and inventory models in order to increase 

basic understanding ASDN software. 

 

The second objective is study the definition and function modules of ASDN software 

in order to understanding application of ASDN tool. 

 

The third objective is use ASDN tool to design a complex toy supply demand 

networks and explain related inventory models calculation. 

 

The fourth objective is use ASDN tool to create graph interface to analysis the 

complex toy supply demand networks, and optimize the analysis results. 
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1.3. Structure of the thesis 

In Chapter 1, the background of the study, research problem, research objectives, and 

structure of the thesis are presented.  

 

In Chapter 2, provides theoretical perspective of previous studies. For instant, 

backgrounds of agility, definition of agility and agile supply chain management, 

characteristics of the agile supply chain, benefits of agile supply chain, demand and 

supply chain management, demand response strategies and inventory models are 

presented in this chapter. 

 

In Chapter 3, explain ASDN software. Includes definition of ASDN, the software 

background information and the functional modules of the ASDN tool are presented in 

this chapter. 

 

In Chapter 4, practical application the ASDN software to developing a case example, 

analyze and optimize the result. In this chapter present the design processing of the 

example, the each step in calculations will visualized in the text and equation, discuss 

the analyze reports and optimize the analysis result.  

 

In Chapter 5, the summary and conclusions of the present study are presented in this 

chapter. There are two subchapters. In the first subchapter, the present study is 

summarized the study and answer the research problem. Conclusions are given in the 

second subchapter, in which the results in application of ASDN software and 

limitations of the study are given. 
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2. THEORY 

In this chapter provides theoretical perspective of previous studies. For instant, 

backgrounds of agility, definition of agility and agile supply chain management, 

characteristics of the agile supply chain, benefits of agile supply chain, demand and 

supply chain management, demand response strategies and inventory model are 

presented in this chapter. 

 

2.1. Agility 

To understand agile supply chain, we need to first clarify the meaning of agility. In 

brief, Agile means fast moving. The concept of Agility defines as ability to respond 

quickly and effectively to satisfy customers (Veeramain & Joshi, 1997). To be reliable 

in an uncertain and changing environment, firms must be able to quickly respond to 

changes. The ability to do this in a useful time frame is called agility (Prater, Biehl & 

Smith, 2001). Agility means using market knowledge and virtual corporation to 

exploit profitable opportunities in a volatile market (Cai-fen, 2009). Agility is all 

about customer responsiveness, people and information, cooperation within and 

between firms and fitting a company for change (Intaher, 2010). 

Agility can be seen as the capability to make a profit by keeping productivity level 

high in a changing environment. Volume levels and product mix may fluctuate and 

life cycles change. The agility of a manufacturing system is considered to be a 

derivative of these generic dimensions. The practical aspects, used in this model, are 

volume flexibility; mix flexibility and life cycle flexibility (Helo, 2004). Agility is the 

capability to react to change in a dimension beyond flexibility. Flexibility refers to 

company’s ability to adjust from one operation to another (Vokurka & Fliedner, 1998). 
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The key difference according to Vokurka and Fliedner is the ability to react to 

non-predictable changes in markets. 

Companies must quickly identify, design, manufacture, and deliver products that meet 

customer desires, while maintaining stringent cost and quality standards. More 

specifically, greater importance is being placed on agility in terms of producing a 

broad range of low-cost, high-quality products with short lead times in varying of 

sizes, built to individual customer specifications (Narasimhan & Das, 1999). See 

Figure 1 for four strategic dimensional of agile competition: Enriching customers; 

Cooperating to enhance competitiveness; organizing to master change and uncertainty; 

Leveraging the impact of people and information (Steven,1994). 

 

Figure 1. Four strategic dimensional of agile competition (Colin, 2000). 

 

Enriching customer means an agile company’s products perceived by its customers to 

be solutions to their individual problems, not only themselves of company. Cooperating 

to enhance competitiveness means an agile company cooperates internally or with other 

companies bringing agile products to markets as rapidly and as cost-effectively as 

possible. Organizing to master change and uncertainty means an agile company is 
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organized in a way that allows it to thrive on change and uncertainty. Is structure is 

flexible enough to allow rapid reconfiguration of human and physical resources. 

Operation leveraging the impact of people and information by distributing authority, by 

providing the resources personnel need, by reinforcing a climate of mutual 

responsibility for joint success, and by rewarding innovation. Knowledge-based 

products offer the greatest potential for individualization, so continuous work force 

education and training are integral to agile company operations (Steven, 1994).  

 

2.2. Agile Supply Chain Management 

This subchapter will list the definition of agile supply chain management and explain 

why we need agile supply chain management for organizes. 

 

2.2.1. What is ASCM 

The concept of agile supply chains was introduced (Harrison et al., 1999) to transfer 

and apply the winning strategy of agility to that of supply chains addressing these as 

the newly accepted units of business. The idea of agility in the context of SCM 

focuses on “responsiveness” (Lee & Lau, 1999; Christopher &Towill, 2000).  

Li et al. (2008) introduce a unifying general-purpose definition of supply chain agility 

as follows: An organization’s supply chain agility is the result of integrating the 

supply chain’s alertness to changes (opportunities/challenges) – both internal and 

environmental – with the supply chain’s capability to use resources in responding 

(proactively/reactively) to such changes, all in a timely and flexible manner (Xun, 

Thomas & Clyde, 2009). 
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The concept of the agile supply chain is advocated as a new way forward for business 

networks to succeed in the highly changing and turbulent business environments. The 

main focus is in running businesses in network structures with an adequate level of 

agility to effectively respond to changes, as well as proactively anticipate changes and 

to seek emerging opportunities. Agile supply chains are, therefore, those with the 

ability to rapidly align the network and its operations to the dynamic and turbulent 

requirements of the demand network (Sharifi, Ismail & Reid, 2006).  

Supply chain agility is a network‘s ability to consistently identify and capture 

business opportunities more quickly than its rivals do. Elements of Agile supply chain 

have time competitive and efficient consumer responsive. It provides ability. The 

ability to be able to meet the demand of customers for ever-shouter delivery times and 

to ensure that supply can be synchronized to meet the peaks and troughs of demand is 

clearly of critical importance in this era of time-base competition. To become more 

responsive to the needs of the market requires more than speed, it also requires a high 

level of maneuverability that today has come to be termed agility (Cai-fen, 2009). 

In general, an agile supply chain is all about being fast and flexible. Lee (2004) 

specifies that the main objectives of supply chain agility are to respond to short-term 

changes in demand or supply quickly and to handle external disruptions smoothly. 

Intuitively, agile supply chain is also highly market responsive, because it is able to 

fast react on sudden demand peaks. Fisher (1997) states that innovative products 

should always require responsive supply chain that responds quickly to unpredictable 

demand in order to minimize stock-outs, forced markdowns and obsolete inventory 

(Jari & Dennis, 2006). 

Christopher (2000) defines four key characteristics for agile supply chain, as show in 

below figure 2. First, an agile supply chain is always market sensitive with capability 
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of reading and responding to real demand. Focus is on capturing actual customer 

requirements with direct feed-forward methods and not to rely much on market 

forecast information. It is always more demand-driven rather than forecast-driven. 

Second, extensive demand and supply information sharing between buyers and 

suppliers creates a virtual supply chains are information based rather than inventory 

based. The third key characteristic for agility is process integration between the 

partners. The extensive demand information sharing also enables truly collaborative 

working methods, joint product development and common systems between buyers 

and suppliers. Fourth, agile supply chain typically is network based with shared 

targets. The supply chain partners create competing networks with committed and 

close relationships with their final customers (Jari & Dennis, 2006). 

 

Figure 2. Four key characteristics for agile supply chain. 
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2.2.2. Why ASCM 

In the 21st market environment today, proliferation of products and services are 

increased, demand will be increasingly difficult to forecast, product life cycles will be 

shorter and rates of product innovation will be increased. Simply responding quickly 

and at the right time in the past are not enough to meet the needs of such marketplaces 

(Cai-fen, 2009). This gave rise to the supply chain management concept, which 

integrates suppliers, manufacturers, distributors and customers to, first, reduce costs 

over the entire chain and, second, respond quickly to customer needs (Thomas & 

Griffin, 1996). So Agile supply chain emerged, which will combine needs of demand 

and quickly delivery. 

To be competitive, companies must adapt their supply chains efficiently and build 

strong relationships with customers and suppliers more quickly (Tolone, 2000). A 

company cannot become agile unless its relationships with the supply chain are also 

agile. Supply chain agility is a key to inventory reduction, adapting to market variations 

more efficiently, enabling enterprises to respond to customer demand more quickly, 

and integrating with suppliers more effectively (Scott J., Michael H., Brian T. & Li, 

2002). Therefore, why supply chain agility and responsiveness have already become 

more or less standards in the industry. Agility alone does not anymore provide a 

competitive advantage in supply chains, but it is rather a prerequisite for the 

competition (Jari & Dennis, 2006). 

 

Supply chain management (SCM) is an integrative philosophy to manage the total 

flows of a distribution channel from suppliers level to production, distribution and the 

ultimately the end customer (Houlihan, 1987; Cooper et al., 1997; Simchi-Levi et al., 

2000; Tam et al., 2002; Helo and Bulcsu, 2005). Traditional supply chain management 

(SCM) policies are process-driven and have used production to forecast policy. 
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Compare with traditional SCM, Agile supply chain management (ASCM) can 

effectively or efficiently support a customer-driven and dynamically changing market. 

ASCM is consider the integration of a business network, encompassing suppliers, 

manufacturers, distributors and retailers, in order to provide products and services 

along with the added value to end customers (Yan et al., 2003). Much work has been 

geared towards the management of the information, financial and physical flows 

throughout a supply chain network (Huang et al., 2002). Supply chain agile lends itself 

to be an effective means of dealing with product differentiation and customization 

throughout a supply demand network (Yan et al., 2003). It essentially entails the 

instantiation of a generic supply chain network to specific supply chains in accordance 

with diverse customer requirements. 

The figure 3 shows the supply chain relationship between traditional SCM and ASCM. 

ASCM operation no longer follows a linear model, which system is a network-based 

operation that requires timely available of information throughout the system in order 

to allow cooperative and synchronized flow of material, products and information 

among all participants (Helo, Xiao & Jiao, 2006). At the same time, below list the 

compare between traditional SCM and ASCM. 

 

Figure 3. SCM and ASCM. 
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SCM                                                          ASCM 

Linear model                                             Network model 

Process - driven                                         Customer – driven 

High lead-time                                             Low lead-time 

Focus on efficiency and cost            Focus on effectiveness and responsiveness 

Stock is held at multiple echelons             Stock is held at the fewest echelons 

Strategic inventory driven by forecast        Strategic inventory driven by demand 

Discrete organizational units of production           Across functional boundaries 

 

2.3. Demand Supply Chain Management 

Demand supply chain management need to coordinate the demand and supply 

processes has been emphasized in the chain of organizations. Companies embracing the 

demand-led business model (demand chain masters) focus on coordinating and 

managing the demand processes (DCM) to obtain a competitive advantage by 

providing superior customer value while companies embracing the supply led business 

model (supply chain masters) focus on coordinating and managing the supply processes 

(SCM) to obtain a competitive advantage by providing comparable customer value at 

lower cost (Walters, 2008; Hilletofth, 2011). 

 

In customer-centered marketing approach, the chain of organization need for DCM to 

be in charge of SCM, which means in environments with increasing diversity, in 

customer needs and requirements, companies must rapidly adjust their supply to meet 

demand (Sheth, Sisodia & Sharan, 2000). Moreover, the market-driven companies can 
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gain a more sustainable competitive advantage by not only providing superior customer 

value propositions, but also by having a unique business system to support it (Kumar, 

Scheer & Kotler, 2000). 

 

Demand supply chain management will help organization to gain a competitive 

advantage by providing superior customer value at lower cost. To achieve the goal, the 

company need understanding managing the demand chain the supply chain, and the 

processes and management directions can be coordinated (Hilletofth, 2011). Below the 

figure 4 shows the coordination of DCM and SCM across intra- and 

inter-organizational boundaries. 

 

 

Figure 4. Demand-Supply Chain Management. 
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2.4. Demand Response Strategies 

Any order for an end product trigger a series of work processes in the supply chain that 

have to be completed so that the end customer order is satisfied (Ming, 2001). 

Generally, the following demand management strategies are employed in supply chain 

management. 

 

The make-to-order (MTO) systems offer a high variety of customer-specific and 

typically, more expensive products. The production planning focus is on order 

execution and the performance measures are order focused e.g. average response time, 

average order delay. The competitive priority is shorter delivery lead-time. Capacity 

planning, order acceptance/rejection, and attaining high due date adherence are the 

main operations issues (Soman, Donk &Gaalman, 2004).  

 

The make-to-stock (MTS) systems offer a low variety of producer-specified and 

typically, less expensive products. The focus is on anticipating the demand 

(forecasting), and planning to meet the demand. The competitive priority is higher fill 

rate. The main operations issues are inventory planning, lot size determination and 

demand forecasting (Soman, Donk &Gaalman, 2004). 

 

The assemble-to-order (ATO) systems offer a high level of product variety to 

customers, while maintaining reasonable response times and costs. The focus is on 

rapidly assembled from component inventories in response to customer orders 

(Plambeck & Ward, 2007). The competitive priority is efficient to deliver products to 

customer. The main operations issues are coordination of the components, allocation of 

the component among the products (Song & Zipkin, 2003). 

 

The engineer-to-order (ETO) systems offer high level of customization, high 
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customers design, volume flexible, short cycle time, no inventory costs products 

(Molina, Velandia & Galeano, 2007). The productions focus on receiving customer 

requirement and approval by the customer (Ming, 2001), while the systems 

coordination between production and sales (Bertrand, Wortmann & Wigingaard, 1991; 

Giesberts & Tang, 1992). The competitive priority is specific products to customer 

order and quickly defines aggregate networks for new project (Giesberts & Tang, 1992). 

The main operations issues are capacity planning and customer order scheduling. 

 

 

Figure 5. Different PDS relate to ODP. 

Figure 5 shows different demand response strategies relate to different position of the 

order decoupling point. The dotted lines depict the production activities that are 

forecast-driven, whereas the straight lines depict customer order-driven activities 

(Olhager, 2003). Below the table 1 gives the attribute comparison between different 

demand management strategies (Ming, 2001).  

 

The order-decoupling point (ODP) defined as the point in the manufacturing value 

chain for a product, where the product is linked to a specific customer order. Different 

manufacturing situations such as make-to-stock (MTS), assemble-to-order (ATO), 

make-to-order (MTO) and engineer-to-order (ETO) all relate to different positions of 

the ODP (Olhager, 2003). The decoupling point is the point in the material flow streams 

to which the customer’s order penetrates. It is here where order-driven and the forecast 
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driven activities meet. As a rule, the decoupling point coincides with an important stock 

point - in control terms a main stock point - from which the customer has to be supplied 

(Hoekstra & Romme 1992; Mason-Jones, Naylor & Towill, 2000). The point also is 

strategic stock which often held as a buffer between fluctuating customer orders and/or 

product variety and smooth production output (Helo, Xiao & Jiao, 2006).  

 

A major problem in most supply chains is their limited visibility of real demand 

(Christopher, 2000). So we presented with the decoupling point in different positions 

along the supply chain as a stock holding point. In order to, lower inventory levels and 

enhance customer service via improved agility of manufacturing (Spathis & 

Constantinides, 2003). 

 

 

Table 1. Comparison different demand response strategies. 
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2.5. Inventory Models 

If the money promote our world turning, then we can say that the inventory promote 

logistics world turning. Demand variability increases as one move up the supply chain 

away from customer and any small changes in customer demand can result in large 

variation in orders upstream. This phenomenon is known as bullwhip effect (Alok, 

2006). The key problem of inventory is having enough items available when needed, 

but not so much that an unnecessarily costly surplus is incurred (Richard, 1982). So 

study inventory models for uncertain demand become necessary.  

 

Inventory model definition as mathematical equation or formula that helps a firm in 

determining the economic order quantity, and the frequency of ordering, to keep goods 

or service flowing to the customer without interruption or delay. If a company stored 

too little inventory it causes costly interruptions and too much result in idle capacity. 

The inventory model determines the inventory level that balances the two extreme 

cases (http://www.oppapers.com/essays/Problems-On-Inventory-Model/637464). In 

this subchapter, we will consider several types of models start with ASDN tool in the 

next section. 

 

Supplier Lead Time  

Supplier lead time means expected time to get all components from suppliers. For this 

part calculate, the numerical of lead time to customer come from the upstream section, 

the numerical of order lead time come from the transport lead time.  

 

Internal Lead Time 

Internal lead time decided by the order decoupling point. The ILT equal to shipping 

time when the manufacturing situation is MTS; ILT is shipping time plus production 

throughput time (TPT) if ATO; ILT is shipping time plus TPT plus supplier lead time if 

http://www.oppapers.com/essays/Problems-On-Inventory-Model/637464�
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MTO; ILT is sum of shipping time, TPT, supplier lead time and engineering lead time if 

ETO. 

 

Lead time To Customer  

Lead time to customer means the how long of the operation time to customer. The lead 

time calculate result effect by internal lead time, order backlog and order time to 

delivery. 

 

Service Level 

Service level is defined as the percentage of demand in linear feet met from stock 

(Nahmias 1989; Xiong & helo, 2006). Service level is often measured in terms of an 

order cycle time, case fill rate, line fill rate, order fill rate, or any combination of these 

(Bowersox, Closs & Cooper, 2002). While one strategy to achieve a high service level 

is to increase inventory, other alternative approaches are the use of fast transportation 

and collaboration with customers and service providers to reduce uncertainty 

(Bowersox, Closs & Cooper, 2002). 

 

Cycle Stock  

Cycle stock means portion of inventory available (or planned to be available) for the 

normal demand during a given period, excluding excess stock and safety stock. It is the 

stock formed by items arriving infrequently but in large quantities to meet frequent but 

small-quantity demands 

(http://www.businessdictionary.com/definition/cycle-stock.html#ixzz1vzxiei20).  

 

Safety Stock 

The majority of inventory in the typical logistics system is typically safety stock. Safety 

stock is maintained in a logistical system to protect against demand and performance 

cycle uncertainty. Safety stock inventory is used only at the end of replenishment 

http://www.businessdictionary.com/definition/cycle-stock.html#ixzz1vzxiei20�
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cycles when uncertainty has caused higher than expected demand or longer than 

expected performance cycle times (Bowersox, Closs & Cooper, 2002). The equation of 

safety stock is  

SS = 𝑆𝐹 ∗  𝜎 ∗ √𝑟 + 𝐿 

 

Where SS is the system safety stock, SF is the safety factory which determines percent 

of service level, σ is the standard deviation of period demand, r is the time period 

between orders, and L is the delivery time of each other (Siefering, 2005). 

 

Inventory Value  

Inventory value is a definition in business that accounts for the value a business has for 

inventory that it has yet to sell. Inventory value is generally calculated at the end of a 

company accounting period (for example, at the end of a quarter evaluation) in order to 

accurately represent the value of the company, since unsold inventory has a value that 

must be accounted for 

(http://www.ehow.com/how_6505792_calculate-inventory-value.html#ixzz1vzvPcF1

Z). 

 

Average Inventory 

Average inventory consists of the materials, components, work-in-process, and 

finished product typically stocked in the logistical system. From a policy viewpoint 

target inventory levels must be planned for each facility (Bowersox, Closs & Cooper, 

2002).The average inventory focus of logistical management is one-half order quantity 

plus safety stock (Bowersox, Closs & Cooper, 2002). 

 

Inventory Turn Rate  

Inventory turns means the number if times that the inventory is replaced during a time 

period (usually a year). The standard accounting measure for inventory turns is the cost 
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of goods sold divided by the average inventory investment (Hill, 2012). 

 

Theory of Constraints (TOC) 

The theory of constraints (TOC) adopts the common idiom "A chain is no stronger than 

its weakest link" as a new management paradigm. This means that processes, 

organizations, etc., are vulnerable because the weakest person or part can always 

damage or break them or at least adversely affect the outcome 

(http://en.wikipedia.org/wiki/Theory_of_Constraints). According to Goldratt et al. 

(2000), a good measure is required to bind each party to be accountable to improve 

supply chain performance as a whole. The TOC promotes inventory dollar days (IDD) 

as a measure of things done ahead of schedule and throughput dollar days (TDD) as a 

measure of things done behind schedule (Hill, 2012). The goal is attempts to reach zero 

TDD with as few IDD as possible. 

 

Inventory Dollar Days (IDD) 

Inventory dollar days (IDD) as a metric to be used to enable the supplier to judge the 

retailer’s inventory performance. IDD equal the sum of the dollars of inventory times 

the number of days on hand. The supplier can also offer the same measure to its vendors 

so they can measure the supplier’s inventory performance (Simatupang & Sridharan, 

2003). 

 

Throughput Dollar Days (TDD) 

The retailer can judge the delivery performance of its suppliers by using the throughput 

dollar days (TDD) that equal the sum of sales dollars times the number of days’ delay. 

The supplier can use TDD to judge the delivery performance of its vendors. The 

supplier will be responsible for the results as measured by TDD (Simatupang & 

Sridharan, 2003). 

 

http://en.wikipedia.org/wiki/Theory_of_Constraints�


29 

Order point system 

When the quantity of an item on hand in inventory falls to a predetermined level, called 

an order point, an order is placed. The quantity ordered is usually recalculated and 

based on economic-order-quantity concepts. Below the figure 6 shows the relationship 

between safety stock, order lead time, order quantity, and order point. The order point is 

determined by the average demand during the lead time. If the average demand or the 

order lead time changes and there is no corresponding change in the order point, 

effectively there has been a change in safety stock 

(http://mdcegypt.com/Pages/Purchasing/Material%20Management/Independent%20D

emand%20Ordering%20Systems.asp).  

 

 

Figure 6. Inventory level Vs. Time. 

 

Economic Order Quantity (EOQ) Model 

The EOQ model is to find the optimal order quantity of inventory items at each time 

such that the combination of the order cost and the stock cost is minimal (Wang, Tang & 

Zhao 2007). EOQ model can be used to make optimal inventory decisions when 

demand is deterministic. The EOQ does not depend on the unit purchasing price, 

because the size of each order does not change the unit purchasing cost. Thus, the total 

http://mdcegypt.com/Pages/Purchasing/Material%20Management/Independent%20Demand%20Ordering%20Systems.asp�
http://mdcegypt.com/Pages/Purchasing/Material%20Management/Independent%20Demand%20Ordering%20Systems.asp�
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annual purchasing cost is independent. In figure 7 illustrates the trade-off between 

holding cost and ordering cost. At the same time, the figure confirms the fact that at q*, 

the annual holding and ordering costs are the same (Winston, 2003). 

 

 

Figure 7. Trade-off between holding cost and ordering cost. 

The customer demand is always changing and hence the inventory should also be 

changed in order to optimize inventory-holding cost (Alok, 2006). Traditional 

inventory management because of supplier not sure the order so they need build 

unnecessary inventory. But now application ASDN system will share the information 

between supply point and demand point. The supply chain should be able to act 

according to the change in demand, thus reduce the cost of inventory and minimal the 

lead-time. The detail explain and discuss will show the chapter 4.  
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3. ASDN SOFTWARE 

In this chapter explain ASDN software, which it is includes definition of ASDN, the 

software background information and the functional modules of the ASDN tool are 

presented. 

 

3.1. Definition of ASDN 

ASDN - "Agile Supply Demand Networks" is software for analyzing and developing 

logistics networks. It is software developed for rapid modeling tool of supply chains 

which should help decision-making in network architecture design and performance 

management (ASDN, 2005). ASDN software design case model is drive by customer’s 

requirement; even make fast reconfiguration and adjustment basic different chain 

strategy, so it is can agility and optimizing the level of inventory in industrial network 

operation. ASDN also can be used to analyze project-business networks; while the 

project-business activities can be optimized using the right resources at the right time 

with the right actors to take the right actions in a network approaches (Sandhu & Helo, 

2006). 

 

As a logistics analysis software of ASDN which concentrates on (Sandhu & Helo, 

2006): 

 the development of IT architectures to support global-network modeling and 

design; 

 portraying the present status of network-level control;  

 optimizing supply-demand processes for fast response time; and  

 Improving financial performance. 
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3.2. Background of ASDN software 

Agile supply demand networks (ASDN) software, which was developed at the 

University of Vaasa (Finland), is a network drawing tool for analyzing multi-site 

manufacturing and material flows (ASDN, 2005). ASDN software can help managing 

global supply demand networks to be more agile and time responsive, optimizing the 

level of inventory. It is based on Java Web Applet and equipped with interactive 

communication capabilities between peripheral software tools. It operates as an 

information platform, by which integrate with their customers and suppliers to quickly 

build supply demand network. All the information, activities and decision are 

visualized, synchronized and optimized by ASDN system (Helo, Xiao & Jiao, 2006). 

 

The ASDN software was originally developed for the ABB Corporation to analyze 

large global supply demand networks. In the ASDN model, each node (such as a 

supplier, a manufacturer, or a retailer) is identified as having certain attributes in terms 

of lead-time, inventory levels, and so on. The software enables users to analyze 

industrial network in different scenarios from various perspectives – such as total 

inventory or order-fulfillment time. The calculation functionality of the system allows 

users to define the right levels of inventory to meet commitments to customers while 

minimizing cost. These calculations are based on predefined resource dependencies. 

The user can compare different chain strategies and analyze objectives – such as 

on-time delivery, lower inventory levels, fast delivery, and decreased cost of capital. 

(Sandhu & Helo, 2006).  
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3.3. Architecture of ASDN 

ASDN adopts modular architecture design that the main functions are encapsulated in 

separated modules which are easy to modify and upgrade. The key functional modules 

in ASDN are modeling, optimization, analysis and report, interface, and database. It 

aims for modeling, analyzing, optimizing supply demand network, forms a scalable, 

extensible and interoperable application environment (Helo, Xiao & Jiao, 2006). 

 

Modeling module  It facilitates the user building and configuring the supply chain 

model quickly and efficiently. Users can easily click and drop in the main window to 

draw the supply chain nodes and link the nodes with transport arrows. All the related 

data and information of the network are retrieved and processes by this module to 

provide a straightforward and clear model structure. 

 

Optimization module  A variety of build-in mathematical algorithms are provided to 

optimize specified performance of supply demand network. User could select the 

optimizing models in order to adapt various operational circumstances. Comprehensive 

analytical models and real-time calculation optimize the supply chain from a systematic 

view.  

 

Analysis and report module  This module analyzes the supply demand network 

performance from different kinds of aspect and visualizes the result by a variety of 

geographic and tabular reports. It helps planners and managers to observe the supply 

demand network in a holistic view and examine issues such as: service level, overall 

cost, order fulfillment, inventory value and capacity of production and so on. 

 

Interface  This enables the users and other systems transform the data to ASDN and 

assess the concerned output information. Also it can graphically represent the network 
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distribution including the location of facilities, transport channel, the attribute of 

supplier and customers with all details.  

 

Database module  It stores the data and information related to supply demand network, 

customer demand, supply ontology, etc. For example, the attributes of each company 

node that describe its status would be stored in the database and shared by the 

authorized users. The integrator is used to transform the data and information between 

ASDN and transactional systems according to prescribed rules and format. 
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4. METHODOLOGY 

Toy industry as the creative business faces many challenges, variable and 

unpredictable demands, very short product life cycles, high costs on inventory and so 

on. Toy sellers and manufactures face high levels of risk and volatility. Therefore, 

some toy manufacturers offer early-order or quantity discounts to push the inventory 

risk to the retailers. Some retailers use their buying power to avoid risk-taking or pass 

some costs to the manufacturers (Chee, Jan & John, 2005). Finally both sellers and 

manufacturers have same problem is high levels inventory. ASDN model as strategy 

tool of agile supply chain management can fix the gap of inventory problem, through 

integrated retailers, distributors, manufacturers and suppliers to reduce inventory and 

lead time to customers. 

In this chapter, we are design one simulate example about Barbie Doll products supply 

demand networks at global supply chain environment, then analyze and optimize 

solution with ASDN software. Aim to resolve below the research question through 

application ASDN software. 

 

How to use ASDN software to analyze and optimize current toy industrial logistics 

network? 

 

The figure 8 shows the example of supply demand network infrastructure. This network 

consists of eight elements: four suppliers, one manufacturer, one retailer, one sales 

company and one end customer. The main supplier from China, assemble factory locate 

in China, the finish product ship to North Europe for sale. We use ASDN software to 

designing and developing the case which base on below supply chain map.  
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Figure 8. An example of network infrastructure. 

 

In this chapter, we will use ASDN software to do the below steps:  

 Building the construction of Barbie Doll supply demand networks  

 Report of graph and table view 

 Improvements the base case 

 Save file and exit the ASDN tool 

 Discuss the analysis results  

 

4.1. Building the basic construction 

ASDN is a free software for user to download and easy to set up. In this subchapter we 

will give a brief guideline to use the ASDN software, which enables the user to build 

the required supply demand networks, draw graphs, select and improvement calculate, 

and find better solution. At same time, the calculations results not only display from the 

ASDN software system, but also show side by side coming from equations by hand 

calculate, which in order to prove the ASDN software system has correct calculation 

logic.  
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4.1.1. Navigation of start ASDN software 

In order to build the supply demand network of Barbie Doll product, we need download 

and install ADSN software at first. The software comes from the web server 

(http://sourceforge.net/projects/asdn), which is supported by Java Virtual Machine. So 

we need setup the Java as well if your computer not running Sun's Java, which comes 

from the web server (http://www.java.com/en/download/manual.jsp). Finally, we need 

to download the files of asdn.jnlp which will start and automatically ASDN software. 

From the web server (http://switch.dl.sourceforge.net/sourceforge/asdn/asdn.jnlp) can 

download it. When we work with ASDN software, we need double-click the document 

of asdn.jnlf files to open the ASDN software system at begin. Below the figure 9 shows 

the basic ASDN software screen.  

 

 

Figure 9. Basic ASDN screen. 

 

http://sourceforge.net/projects/asdn�
http://www.java.com/en/download/manual.jsp�
http://switch.dl.sourceforge.net/sourceforge/asdn/asdn.jnlp�
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From the figure 9, we can see that the basic ASDN screen includes three main areas. 

The title-bar, Menu-bar and tool-bar located at the very top of the screen. Attributes 

windows provides the input, output and current status of selected node or arrow of the 

designed network located at the left of the screen. The right white area is the main 

window which use to building the construction of Barbie Doll supply demand network, 

which shows the initial designed logistics network and ‘After improvements’ 

represents the improvement done with the initial network (Guangyu & Natalia, 2008).  

 

4.1.2. Add the Nodes and Input the data 

Node is basic unit of a network, which represents suppliers, manufacturer, retailers and 

customers are added in the main window. Build construction of supply demand 

network use reverse engineering to design and the network by demand-drive , so create 

the start node will come from customers, then manufacturer, the last is suppliers. Select 

Edit > Add Node from the main menu-bar, a new node appears. The figure 10 shows the 

node of end customer. When we highlight (turn into blue color) the node, the data can 

be input through a series of on-screen format. We can define and modify the input data 

in the section of general, finance, manufacturing and inventory. From the left input 

panel we select the node type as “end customer”, order decoupling point as 

“make-to-stock”, enter price as “35.0€”, cost as “35.0€”, demand as “800.0units/year”, 

demand st. deviation “96.0 units/year”, working time as “52.0weeks”, production 

throughput time as “1.0days”, St. deviation of OLT and order backlog as “0.0days”, 

engineering lead-time and maximum order fulfillment time as “0.0days”, capacity as 

“800.0units/day”, holding cost rate as “10.0%”. Attributes of a node show at figure 11, 

which explain the number function of node  
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Figure 10. The Node of end customer. 

 

 

Figure 11. Attributes of a node. 
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Figure 12. The node of retailer. 

The figure 12 shows other node of customer, named “OEM customer (Sweden)” and 

type as “retail” When we highlight (turn into blue color) the node, input data show on 

the left of attributes windows. Next we are adding node type as “sales company” and 

label name as “SOKOS (Finland)”, the input data shown in the left of figure 13.  

 

 

Figure 13. The node of sales company. 

 



41 

Continue to added node of manufacturer, the highlight (blue color) node type as 

“manufacturing” and label as “Barbie Doll factory (China)” show in figure 14. 

 

 

Figure 14. The node of manufacturing. 

 

Finally to add the node of suppler, the figure 15 shows the nodes of four suppliers 

which respective named as Doll hair, Doll clothes, Doll body and Doll shoes. We can 

input different information from each node of supplier by clicking the intended node. 

For example, highlight (Blue color) the node of supplier named “supplier for doll hair” 

(Goods originate from China) and its information such as: label as “doll hair (China)”, 

type as “supplier”, order decoupling point as “Make-to-Stock”, price as “0.65€”, cost as 

“0.5€”, demand as “0.0 units/year”, Demand st. deviation “0.0units/year”, working 

time as “52.0weeks”, production throughput time as “1.0days”, St. deviation of OLT as 

“0.5days”, order backlog as “2.0days”,shipping time as “1.0days”, engineering 

lead-time as “1.5days”, maximum order fulfillment time as “0.0days”, Capacity as 

“2000.0 units/day”, OTD as “68.0%”holding cost rate as “10.0%” are displayed in the 

input section on the left side of the attributes window. Other leave suppliers input the 
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information process at the same way. 

 

 

Figure 15. The node of suppler. 

 

4.1.3. Add the arrows 

Arrow is an element of a network which connects nodes with each other. It is also the 

model of transport. To build the arrow, we need highlight (turn to blue color) the start 

node at first, Select Edit > Add Arrow from the main menu-bar, then chooses the end 

node and one-click it turn to blue color, a new arrow appears. Next step input data to 

add arrow, when we are highlight (one-click arrow turn to blue color) the select arrow 

and the input section display on the left side screen. Below the figure 16 show the 

attributes of an arrow. 
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Figure 16. Attributes of an arrow. 

 

Below figure 17 shows the arrow from the start node of manufacturing to end node of 

retailer. Same like node of input section, we can define and modify the input data in the 

section of general and number. From the left input panel we select the arrow type as 

“ship”, price as “7300.0€”, cost as “6800.0€”,transportation time as “28.0days”, service 

lvl as “90.0%”, Inv.lvl.cur as “1.0units”, Inv.lvl.min and max as “1.0units”, lot-size as 

“1.0units”, transport frequency as “10.0days”, number of lots as “0.0”, holding cost rate 

as “10.0%”. After the arrow connect between the node of manufacturing and the node 

of retail, the node of manufacturing input data in the section of general changed 

immediately. From the left input panel display the demand as “2000.0units/year” and 

demand st. deviation “240.0 units/year” shown in figure 18. That mean the demand data 

of each node will change after add arrow connect to node of end, the demand data will 

base on the node of customers’ demand data automatically change.  
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Figure 17. Add arrow from manufacturer to retailer. 

 

 

Figure 18. Arrow connects manufacturing and retailer. 

 

Figure 19 shows the arrow from the start node of retailer to end node of end customer. 

Figure 20 shows the arrow from the start node of manufacturer to end node of end 

retailer. From figure 21 to figure 24 separate displays four suppliers connect 

manufacture with arrows. All the input number displayed in the input section on the left 
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side of the attributes window. 

 

 

Figure 19. Add arrow from sales company to end customer. 

 

 

Figure 20. Add arrow from manufacturer to sales company. 
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Figure 21. Add arrow from supplier to manufacturer. 

 

 

Figure 22. Add arrow from supplier to manufacturer. 
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Figure 23. Add arrow from supplier to manufacturer. 

 

 

Figure 24. Add arrow from supplier to manufacturer. 
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Figure 25. Supply Demand network of Barbie doll product. 

 

After define and modify all input data for each arrow, we have already done the base 

construction. From above figure 25 shows supply demand network which combination 

of nodes and arrows layout of supplier-customers relationship with different color. The 

node show four different colors in the base network construction. The colors represent a 

level of OTD (On time to delivery), which means percent of how many orders are 

currently delivered on time. The percent level of OTD show on the below list:  

 95% > Green level > 100%  

 85% > Yellow level > 95% 

 75% > Brown level > 85% 

 0% > Red level >75% 

 

The lower left corner shows the output data of total networks based on our input data to 

each node and arrow in the network. Its information such as; order lead time for 

customer: 47.0, average inventory in units: 127, average inventory in EUR: 2504, 

capacity constraint node: SOKOS (Finland). All the list of information will 

automatically change with BOM (Bill of materials) or improvement of node. 
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4.1.4. Output the data  

In the output section of the window, we can get detail information from Manufacturing, 

Inventory, In (Out) bound and TOC. Below from the figure 26 to figure 33 show the 

Node of output data information. In this subchapter, the calculations results not only 

display from automatism calculate of ASDN software system, but also show the 

process of calculate side by side coming from equations by hand calculate. Aim to 

explain the ASDN software how to get the numbers of output data and prove the 

calculation logic of ASDN tool. 

 

All the calculations equations of the output, while it can found from the Menu-bar click 

Tools select Inventory Models, then the new window of appear will display all the 

information.  

 

 

Figure 26. Node of end customer output. 
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Supplier Lead Time  

SLT means expected time to get all components from suppliers. For this part calculate, 

the numerical of lead time to customer come from the upstream section, the numerical 

of order lead time come from the transport lead time. Because the Sokos sales company 

lead time to customer is 1.05days and the transportation order lead time from the sales 

company to end customer is 0.5day.  

Supplier lead time = Lead time to customer + Order lead time 

So SLT = 1.05 days + 0.5day = 1.55days. 

 

Internal Lead Time 

If odp=MTS: X = Shipping time, if odp = ATO: X = Shipping time + Production 

Throughput Time (TPT), if odp = MTO: X = Shipping time + TPT + Supplier lead-time, 

if odp = ETO: X=Shipping time + TPT + Supplier lead-time + Engineering lead-time. 

End customers=MTS: X = Shipping time, at same time the shipping time of end 

customer is 0.0 day, so the internal lead time of end customer is 0.0day. 

 

Lead time To Customer  

Lead time to customer means the how long of the operation time to customer. The 

numerical of order backlog come from the downstream section. Because the internal 

lead time and order backlog is 0.0day, OTD is 99.99. 

LTC = Order backlog + Internal lead-time + ((100 - OTD)/100)*Internal lead-time 

So LTC = 0.0day + 0.0days + ((100 – 99.99)/100)*0.0day = 0.0day. 

 

Service  

Service means percent of how many orders are currently delivered on time, which equal 

to the OTD (On time delivery), so the result is 99, 99%. 
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Cycle Stock Inbound 

CIS means amount of units required for the reorder time. For end customer not need to 

think about this, so the number is 0.0units.  

CS = Demand * Transport Freq/2 

So CS= 800units / 365days * 0.0 days / 2 = 0.0unit. 

 

Safety Inbound Stock 

SIS is Safety stock which kept for the uncertainty from supply.  

SIS = sf * Math.sqrt(Math.pow(demand, 2) * Math.pow(transportLtcv, 2) + slt * 

Math.pow(dsd, 2) 

SF = service factor, sf =3.72 for a 99.9% service level 

SLT = supplier lead time 

DSD = Demand st. deviation 

So SIS = 3.72 ∗ �(800 units
365 days 

)2 ∗  (0.0 day)2 +  1.55 days ∗ (96unites
365 days

)2 =   1.22unites.  

 

Cycle Stock Outbound 

CSO = demand * (LT+OB) / 2 

LT = lead time 

OB = order backlog 

So CSO = 800unites / 365days * (0.0day + 0.0day) / 2 = 0.0unit. 

 

Safety Outbound Stock  

SOS means kept for the uncertainty from demand.  

SOS = sf * Math.sqrt(Math.pow(demand,2)*Math.pow(Ltcv,2) +lt*Math.pow(dsd, 2) 

SF = service factor, sf =3.72 for a 99.99% service level 

LT = lead time 

DSD = Demand st. deviation 
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So SOS = 3.72 ∗ �(800 units
365 days 

)2 ∗  (0.0 day)2 +  1.0 day ∗ (96unites
365 days

)2 =   0.98 unite. 

 

Outbound Inventory Value  

OIV = Cost * Safety outbound stock 

So OIV = 35.0€ * 0.98unit = 34.3€. 

 

Average inventory in UNITS  

AIU = Total Cycle Stock + Total Safety Inbound Stock + CS Outbound + Safety 

Outbound Stock 

So AIU = 0.0unit + 1.22units + 1.1units + 0.98unit = 3.3units. 

 

Average inventory in EUR  

AIE = (Total Cycle Stock + Total Safety Inbound Stock) * Cost + (CS Outbound + 

Safety Outbound Stock) * price 

So AIE = (0.0 unit + 1.22 units) * 35.0€ + (1.1 units + 0.98unit) * 35.0€ = 115.5€. 

 

Inventory Turn Rate  

ITR means Demand per year divided by average inventory in units.  

Inventory turn rate = Demand * 365/Average inventory in units  

So ITR = 800units/year * 365/3.29units = 243.16days. 

 

Inbound Inventory Value  

IIV = Cost * Average inventory in units  

Average inventory in units = CSI + SSO 

So IIV= 35.0€ * (0.0unit + 1.22units) = 42.7€. 

 

Capacity Utilization  

CU = Demand/capacity*100 
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So CU = D/C*100 = 800units/365days/800units * 100 = 0.27%. 

 

Throughput Dollar Days  

IDD = (Price - Cost)/Manufacturing stage time * MIN (demand, capacity). For End 

customer the price equal to the cost, so the function result is 0.0 € /day. 

 

Inventory Dollar Days  

Inventory dollar-days are the dollar-value of the inventory at hand multiplied by the 

time since the inventory entered the responsibility of the link.  

IDD = tiv * itr 

TIV = Totally Inventory Value = Average inventory in EUR  

ITR = Inventory Turn Rate 

So IDD= 115.23€ * 242.98days = 27998.59€/day. 

 

 

Figure 27. Node of sales company output. 

 

Supplier Lead Time  

SLT = Lead time to customer + Order lead time 
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From Barbie doll factory to Sokos sales company lead time is 1.1days, and the ground 

transport time means order lead time is 8.5days from the Sokos sales company to End 

customer.  

So SLT = 1.1days + 8.5days = 9.6days. 

 

Internal Lead Time 

Sokos sales company=MTS: X = Shipping time 

So ILT = 1.0 day. 

 

Lead Time to Customer 

The numerical of order backlog come from the downstream section. The order backlog 

come from the End customer’s input data is 0.0day.  

LTC = Order backlog + Internal lead-time + ((100 - OTD)/100) * Internal lead-time 

So LTC = 0.0day + 1.0day + ((100- 95)/100)*1.0day = 1.05days 

 

Service  

S = OTD (On time delivery) = 95%. 

 

Cycle Stock Inbound 

CSI = Demand * Transport Freq/2 

So CS = 800units/365 days*3.0 days/2 = 3.29 units. 

 

Safety Inbound Stock  

SIS = sf * Math.sqrt(Math.pow(demand, 2)*Math.pow(transportLtcv, 2) + 

slt*Math.pow(dsd, 2) 

SF = service factor, sf =1.64 for a 95% service level 

SLT = supplier lead time 

DSD = Demand st. deviation 
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So SIS = 1.64 ∗ �(800 units
365 days 

)2 ∗  (0.0 day)2 +  9.6 days ∗ (96unites
365 days

)2 =   1.34 unites.  

 

Cycle Stock Outbound 

CSO = demand * (LT+OB) / 2 

LT= lead time 

OB = order backlog 

So CSO = 800unites/365days*(1.0day + 2.0days) / 2 = 3.29units. 

 

Safety Outbound Stock  

SOS= sf*Math.sqrt(Math.pow(demand, 2)*Math.pow(Ltcv, 2)+lt*Math.pow(dsd, 2) 

SF = service factor, sf =1.64 for a 95% service level 

LTCV = St.deviation of OLT 

DSD = Demand st. deviation 

So SOS = 1.64 ∗ �(800 units
365 days 

)2 ∗  (0.5 day)2 +  1.0 day ∗ (96unites
365 days

)2 =   1.85 unites.  

 

Outbound Inventory Value  

OIV = Cost * Safety outbound stock 

So OIV = 30.0€ * 1.85units = 55.5€. 

 

Average Inventory in UNITS 

AIU = Total Cycle Stock + Total Safety Inbound Stock + CS Outbound + Safety 

Outbound Stock 

So AIU= 3.29units + 1.34units + 3.29units + 1.85units = 9.76units.  

 

Average Inventory in EUR  

AIE = (Total Cycle Stock + Total Safety Inbound Stock)*Cost + (CS Outbound + 

Safety Outbound Stock) * price 

So AIE = (3.29units + 1.34units) * 30.0€ + (3.29units + 1.85units) * 35.0€ = 318.8€ 
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Inventory Turn Rate  

ITR = Demand*365/AIU = 800units/year*365 /9.76units = 81.97days. 

 

Inbound Inventory Value  

IIV = Cost * Average inventory in units  

Average inventory in units = CSI + SSO 

So IIV= 30.0€ * (3.29units + 1.34units) = 138.9€. 

 

Capacity Utilization  

CU = Demand/capacity*100 

So CU = D/C*100 = 800units/365days/200units * 100 = 1.1%. 

 

Throughput Dollar Days  

IDD = (Price - Cost)/Manufacturing stage time * MIN (demand, capacity) 

If the demand is 800units with one year, so we can get the time for capacity is 

200unites/day.  

Manufacturing stage time = Production Throughput time (TPT) = 1.0days 

So IDD = (35.0€/unit – 30.0€/unit)/1.0days * 800units/365days = 10.95€/day 

 

Inventory Dollar Days  

IDD = tiv * itr 

TIV = Totally Inventory Value = Average inventory in EUR 

ITR = Inventory Turn Rate 

So IDD= 318.8€ * 81.97days = 26132.04€/day. 
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Figure 28. Node of retailer output. 

 

Supplier Lead Time  

SLT = Lead time to customer + Order lead time 

So SLT = 1.1days + 33.0days = 34.1days. 

 

Internal Lead Time 

OEM customer = MTS: X = Shipping time 

So ILT = 0.0 day. 

 

Lead Time to Customer 

LTC = Order backlog + Internal lead-time + ((100 - OTD)/100) * Internal lead-time 

So LTC = 0.0day + 0.0day + ((100- 100)/100)*1.0day = 0.0day. 

 

Service  

S = OTD (On time delivery) = 99.99%. 
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Cycle Stock Inbound 

CSI = Demand*Transport Freq/2 

So CS = 2000units/365days*10.0 days/2 = 27.4units. 

 

Safety Inbound Stock  

SIS = sf * Math.sqrt(Math.pow(demand, 2)*Math.pow(transportLtcv, 2) + 

slt*Math.pow(dsd, 2), 

SF = service factor, sf =3.72 for a 99.99% service level,  

SLT = supplier lead time, 

DSD = Demand st. deviation, 

So SIS= 3.72 ∗ �(2000 units
365 days 

)2 ∗  (0.0day)2 +  34.1days ∗ (240unites
365 days

)2 =  14.28 unites. 

 

Cycle Stock Outbound  

CSO = demand * (LT+OB) / 2, 

LT= lead time, 

OB = order backlog, 

So CSO = 2000unites/365days*(1.0day + 0.0day) / 2 = 2.74units 

 

Safety Outbound Stock  

SOS= sf*Math.sqrt(Math.pow(demand, 2)*Math.pow(Ltcv, 2)+lt*Math.pow(dsd, 2). 

SF = service factor, sf =3.72 for a 99.99% service level, 

LT= lead time, 

LTCV = St.deviation of OLT, 

DSD = Demand st. deviation, 

So SOS = 3.72 ∗ �(2000 units
365 days 

)2 ∗  (0.0day)2 +  1.0days ∗ (240unites
365 days

)2 =  2.45 unites  

 

Outbound Inventory Value  

OIV = Cost * Safety outbound stock 
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So OIV = 28.0€ * 2.45units = 68.6€. 

 

Average Inventory in UNITS 

AIU = Total Cycle Stock + Total Safety Inbound Stock + CS Outbound + Safety 

Outbound Stock 

So AIU= 27.4units + 14.28units + 2.74units + 2.45units = 46.87units.  

 

Average Inventory in EUR  

AIE = (Total Cycle Stock + Total Safety Inbound Stock)*Cost + (CS Outbound + 

Safety Outbound Stock) * price 

So AIE = (27.4units+14.28units) * 28.0€ + (2.74units + 2.45units)*28.0€ = 1312.36€. 

 

Inventory Turn Rate  

ITR = Demand*365/AIU = 2000units/year*365 /46.87units = 42.67days. 

 

Inbound Inventory Value  

IIV = Cost * Average inventory in units  

Average inventory in units = CSI + SSO 

So IIV= 28.0€ * (27.4units + 14.28units) = 1167.04€. 

 

Capacity Utilization  

CU = Demand/capacity*100 

So CU = D/C*100 = 2000units/365days/2000units * 100 = 0.27%. 

 

Throughput Dollar Days  

IDD = (Price - Cost)/Manufacturing stage time * MIN (demand, capacity).  

For OEM customer the price equal to the cost, so the function result is 0.0 € /day. 
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Inventory Dollar Days  

Inventory dollar-days are the dollar-value of the inventory at hand multiplied by the 

time since the inventory entered the responsibility of the link.  

IDD = tiv * itr 

TIV = Totally Inventory Value = Average inventory in EUR  

ITR = Inventory Turn Rate 

So IDD= 1312.36€ * 42.67days = 55998.40€/day. 

 

 

Figure 29. Node of manufacturer output. 

 

Supplier Lead Time  

SLT = Lead time to customer + Order lead time 

Use the supplier of Doll body to calculate data, because of it take the longest transport 

lean time compare others. 

So SLT = 1.05days + 3.5days = 4.55days. 
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Internal Lead Time 

Factory = MTS: X = Shipping time 

So ILT = 1.0 day. 

 

Lead Time to Customer 

LTC = Order backlog + Internal lead-time + ((100 - OTD)/100) * Internal lead-time 

So LTC = 0.0day + 1.0day + ((100- 90)/100)*1.0day = 1.1days. 

 

Service  

S = OTD (On time delivery) = 90%. 

 

Cycle Stock Inbound 

CSI = Demand*Transport Freq/2 

So CS = 2800units/365days*3.0 days/2 = 11.51units. 

 

Safety Inbound Stock  

SIS = sf * Math.sqrt(Math.pow(demand, 2)*Math.pow(transportLtcv, 2) + 

slt*Math.pow(dsd, 2) 

SF = service factor, sf =1.28 for a 90% service level 

SLT = supplier lead time 

DSD = Demand st. deviation 

So SIS= 1.28 ∗ �(2800 units
365 days 

)2 ∗  (0.0day)2 +  4.55 days ∗ (168unites
365 days

)2 =   1.26unites. 

 

Cycle Stock Outbound  

CSO = demand * (LT+OB) / 2 

LT= lead time 

OB = order backlog 

There have four suppliers to support the factory, so we need calculate the average order 
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backlog at first. 

(Average order backlog = (2.0days + 2.0days + 1.0day +1.0day)/4 = 1.5days) 

So CSO = 2800unites/365days*(1.0day + 1.5days) / 2 = 9.59units 

 

Safety Outbound Stock  

SOS= sf*Math.sqrt(Math.pow(demand, 2)*Math.pow(Ltcv, 2)+lt*Math.pow(dsd, 2) 

SF = service factor, sf =1.28 for a 90% service level 

LT= lead time 

LTCV = St.deviation of OLT 

DSD = Demand st. deviation 

So SOS = 1.28 ∗ �(2800 units
365 days 

)2 ∗  (0.5day)2 +  1.0day ∗ (168unites
365 days

)2 =  4.94 unites. 

 

Outbound Inventory Value  

OIV = Cost * Safety outbound stock 

So OIV = 26.0€ * 4.94 unites = 128.44€. 

 

Average Inventory in UNITS 

AIU = Total Cycle Stock + Total Safety Inbound Stock + CS Outbound + Safety 

Outbound Stock 

So AIU= 11.51units + 1.26units + 9.59units + 4.94units = 27.30units.  

 

Average Inventory in EUR  

AIE = (Total Cycle Stock + Total Safety Inbound Stock)*Cost + (CS Outbound + 

Safety Outbound Stock) * price 

So AIE = (11.51units + 1.26units) * 26.0€ + (9.59units + 4.94units) * 28.0€ = 738.86€ 

 

Inventory Turn Rate  

ITR = Demand*365/AIU = 2800units/year*365 /27.30units = 102.56days. 
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Inbound Inventory Value  

IIV = Cost * Average inventory in units  

Average inventory in units = CSI + SSO 

So IIV= 26.0€ * (11.51units + 1.26units) = 332.02€. 

 

Capacity Utilization  

CU = Demand/capacity*100 

So CU = D/C*100 = 2800units/365days/5000units * 100 = 0.15%. 

 

Throughput Dollar Days  

IDD = (Price - Cost)/Manufacturing stage time * MIN (demand, capacity).  

Manufacturing stage time = Production Throughput time (TPT) = 0.5day 

So IDD = (28.0€/unit – 26.0€/unit)/0.5day * 2800units/365days = 30.68€/day 

 

Inventory Dollar Days  

Inventory dollar-days are the dollar-value of the inventory at hand multiplied by the 

time since the inventory entered the responsibility of the link.  

IDD = tiv * itr 

TIV = Totally Inventory Value = Average inventory in EUR  

ITR = Inventory Turn Rate 

So IDD= 738.86€ * 102.56days = 75777.48€/day. 
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Figure 30. Node of supplier output (Doll Hair). 

 

Supplier Lead Time  

SLT = Lead time to customer + Order lead time 

So SLT = 0.0day + 0.0day = 0.0day. 

 

Internal Lead Time 

Doll hair supplier = MTS: X = Shipping time 

So ILT = 1.0 day. 

 

Lead Time to Customer 

LTC = Order backlog + Internal lead-time + ((100 - OTD)/100) * Internal lead-time 

So LTC = 0.0day + 1.0day + ((100- 68)/100)*1.0day = 1.32days. 

 

Service  

S = OTD (On time delivery) = 68%. 
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Cycle Stock Outbound 

CSO = demand * (LT+OB) / 2 

LT= lead time 

OB = order backlog 

So CSO = 2800unites/365days*(1.0day + 2.0days) / 2 = 11.51units. 

 

Safety Outbound Stock  

SOS= sf*Math.sqrt(Math.pow(demand, 2)*Math.pow(Ltcv, 2)+lt*Math.pow(dsd, 2) 

SF = service factor, sf = 0.52 for a 68% service level 

LT= lead time, 

LTCV = St.deviation of OLT 

DSD = Demand st. deviation 

So SOS = 0.52 ∗ �(2800 units
365 days 

)2 ∗  (0.5day)2 +  1.0day ∗ (168unites
365 days

)2 =  2.00 unites. 

 

Outbound Inventory Value  

OIV = Cost * Safety outbound stock 

So OIV = 0.5€ * 2.0units = 1.0€. 

 

Average Inventory in UNITS 

AIU = Total Cycle Stock + Total Safety Inbound Stock + CS Outbound + Safety 

Outbound Stock 

So AIU= 0.0unit + 0.0unit + 11.51units + 2.00 unites = 13.51units.  

 

Average Inventory in EUR  

AIE = (Total Cycle Stock + Total Safety Inbound Stock)*Cost + (CS Outbound + 

Safety Outbound Stock) * price 

So AIE = (0.0unit + 0.0unit) * 0.5€ + (11.51units + 2.00 unites) * 0.65€ = 8.78€. 
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Inventory Turn Rate  

ITR = Demand*365/AIU = 2800units/year*365 /13.51units = 207.25days. 

 

Capacity Utilization  

CU = Demand/capacity*100 

So CU = D/C*100 = 2800units/365days/2000units * 100 = 0.38%. 

 

Throughput Dollar Days  

IDD = (Price - Cost)/Manufacturing stage time * MIN (demand, capacity).  

Manufacturing stage time = Production Throughput time (TPT) = 1.0day 

So IDD = (0.65€/unit – 0.5€/unit)/1.0day * 2800units/365days = 1.15€/day 

 

Inventory Dollar Days  

Inventory dollar-days are the dollar-value of the inventory at hand multiplied by the 

time since the inventory entered the responsibility of the link.  

IDD = tiv * itr 

TIV = Totally Inventory Value = Average inventory in EUR  

ITR = Inventory Turn Rate 

So IDD= 8.78€ * 207.25days = 1820.0€/day. 
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Figure 31. Node of supplier output (Doll Clothes). 

 

Supplier Lead Time  

SLT = Lead time to customer + Order lead time (Ground transportation) 

So SLT = 0.0day + 0.0day = 0.0day. 

 

Internal Lead Time 

Doll clothes supplier = MTS: X = Shipping time 

So ILT = 1.0 day. 

 

Lead Time to Customer 

LTC = Order backlog + Internal lead-time + ((100 - OTD)/100) * Internal lead-time 

So LTC = 0.0day + 1.0day + ((100- 75)/100)*1.0day = 1.25days. 

 

Service  

S = OTD (On time delivery) = 75%. 
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Cycle Stock Outbound 

CSO = demand * (LT+OB) / 2 

LT= lead time 

OB = order backlog 

So CSO = 2800unites/365days*(1.0day + 2.0days) / 2 = 11.51units. 

 

Safety Outbound Stock  

SOS= sf*Math.sqrt(Math.pow(demand, 2)*Math.pow(Ltcv, 2)+lt*Math.pow(dsd, 2). 

SF = service factor, sf = 0.67 for a 75% service level, 

LT= lead time, 

LTCV = St.deviation of OLT, 

DSD = Demand st. deviation, 

So SOS = 0.67 ∗ �(2800 units
365 days 

)2 ∗  (0.5day)2 +  1.0day ∗ (168unites
365 days

)2 =  2.59 unites. 

 

Outbound Inventory Value  

OIV = Cost * Safety outbound stock 

So OIV = 0.3€ * 2.59units = 0.78€. 

 

Average Inventory in UNITS 

AIU = Total Cycle Stock + Total Safety Inbound Stock + CS Outbound + Safety 

Outbound Stock 

So AIU= 0.0unit + 0.0unit + 11.51units + 2.59units = 14.10units.  

 

Average Inventory in EUR  

AIE = (Total Cycle Stock + Total Safety Inbound Stock)*Cost + (CS Outbound + 

Safety Outbound Stock) * price 

So AIE = (0.0unit + 0.0unit) * 0.3€ + (11.51units + 2.59units) * 0.4€ = 5.64€ 
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Inventory Turn Rate  

ITR = Demand*365/AIU = 2800units/year*365 /14.10units = 198.58days. 

 

Capacity Utilization  

CU = Demand/capacity*100 

So CU = D/C*100 = 2800units/365days/3600units * 100 = 0.21%. 

 

Throughput Dollar Days  

IDD = (Price - Cost)/Manufacturing stage time * MIN (demand, capacity).  

Manufacturing stage time = Production Throughput time (TPT) = 1.0day 

So IDD = (0.4€/unit – 0.3€/unit)/1.0day * 2800units/365days = 0.767€/day. 

 

Inventory Dollar Days  

Inventory dollar-days are the dollar-value of the inventory at hand multiplied by the 

time since the inventory entered the responsibility of the link.  

IDD = tiv * itr 

TIV = Totally Inventory Value = Average inventory in EUR 

ITR = Inventory Turn Rate 

So IDD= 5.64€ * 198.58days = 1119.99€/day. 
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Figure 32. Node of supplier output (Doll Body). 

 

Supplier Lead Time  

SLT = Lead time to customer + Order lead time  

So SLT = 0.0day + 0.0day = 0.0day. 

 

Internal Lead Time 

Doll body supplier = MTS: X = Shipping time 

So ILT = 1.0 day. 

 

Lead Time to Customer 

LTC = Order backlog + Internal lead-time + ((100 - OTD)/100) * Internal lead-time 

So LTC = 0.0day + 1.0day + ((100- 95)/100)*1.0day = 1.05days 

 

Service  

S = OTD (On time delivery) = 95%. 
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Cycle Stock Outbound 

CSO = demand * (LT+OB) / 2 

LT= lead time 

OB = order backlog 

So CSO = 2800unites/365days*(0.5day + 1.0day) / 2 = 5.75units. 

 

Safety Outbound Stock  

SOS= sf*Math.sqrt(Math.pow(demand, 2)*Math.pow(Ltcv, 2)+lt*Math.pow(dsd, 2) 

SF = service factor, sf = 1.64 for a 95% service level 

LT= lead time 

LTCV = St.deviation of OLT 

DSD = Demand st. deviation 

So SOS = 1.64 ∗ �(2800 units
365 days 

)2 ∗  (0.0day)2 +  0.5day ∗ (168unites
365 days

)2 =  0.53 unite. 

 

Outbound Inventory Value  

OIV = Cost * Safety outbound stock 

So OIV = 0.6€ * 0.53unit = 0.318€. 

 

Average Inventory in UNITS 

AIU = Total Cycle Stock + Total Safety Inbound Stock + CS Outbound + Safety 

Outbound Stock 

So AIU= 0.0unit + 0.0unit + 5.75units + 0.53 unite = 6.28units.  

 

Average Inventory in EUR  

AIE = (Total Cycle Stock + Total Safety Inbound Stock)*Cost + (CS Outbound + 

Safety Outbound Stock) * price 

So AIE = (0.0unit + 0.0unit) * 0.6€ + (5.75units + 0.53unite) * 0.8€ = 5.024€ 
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Inventory Turn Rate  

ITR = Demand*365/AIU = 2800units/year*365 /6.29units = 445.15days. 

 

Capacity Utilization  

CU = Demand/capacity*100 

So CU = D/C*100 = 2800units/365days/5000units * 100 = 0.15%. 

 

Throughput Dollar Days  

IDD = (Price - Cost)/Manufacturing stage time * MIN (demand, capacity).  

Manufacturing stage time = Production Throughput time (TPT) = 0.5day 

So IDD = (0.8€/unit – 0.6€/unit)/0.5day * 2800units/365days = 3.068€/day 

 

Inventory Dollar Days  

Inventory dollar-days are the dollar-value of the inventory at hand multiplied by the 

time since the inventory entered the responsibility of the link.  

IDD = tiv * itr 

TIV = Totally Inventory Value = Average inventory in EUR  

ITR = Inventory Turn Rate 

So IDD= 5.03€ * 445.35days = 2240.11€/day. 
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Figure 33. Node of supplier output (Doll Shose). 

 

Supplier Lead Time  

SLT = Lead time to customer + Order lead time 

So SLT = 0.0day + 0.0day = 0.0day. 

 

Internal Lead Time 

Doll shoes supplier = MTS: X = Shipping time 

So ILT = 1.0 day. 

 

Lead Time to Customer 

LTC = Order backlog + Internal lead-time + ((100 - OTD)/100) * Internal lead-time 

So LTC = 0.0day + 1.0day + ((100- 85)/100)*1.0day = 1.15days 

 

Service  

S = OTD (On time delivery) = 85%. 
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Cycle Stock Outbound 

CSO = demand * (LT+OB) / 2 

LT= lead time 

OB = order backlog 

So CSO = 2800unites/365days*(0.5day + 1.0day) / 2 = 5.75units. 

 

Safety Outbound Stock  

SOS= sf*Math.sqrt(Math.pow(demand, 2)*Math.pow(Ltcv, 2)+lt*Math.pow(dsd, 2) 

SF = service factor, sf = 1.04 for a 85% service level 

LT= internal lead time 

LTCV = St.deviation of OLT 

DSD = Demand st. deviation 

So SOS = 1.04 ∗ �(2800 units
365 days 

)2 ∗  (0.0day)2 +  0.5day ∗ (168unites
365 days

)2 =  0.33unite. 

 

Outbound Inventory Value  

OIV = Cost * Safety outbound stock 

So OIV = 0.1€ * 0.33 unite = 0.03€. 

 

Average Inventory in UNITS 

AIU = Total Cycle Stock + Total Safety Inbound Stock + CS Outbound + Safety 

Outbound Stock 

So AIU= 0.0unit + 0.0unit + 5.75units + 0.33 unite = 6.08units.  

 

Average Inventory in EUR  

AIE = (Total Cycle Stock + Total Safety Inbound Stock)*Cost + (CS Outbound + 

Safety Outbound Stock) * price 

So AIE = (0.0unit + 0.0unit) * 0.1€ + (5.75units + 0.33 unite) * 0.15€ = 0.91€. 
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Inventory Turn Rate  

ITR = Demand*365/AIU = 2800units/year*365 /6.08units = 460.53days. 

 

Capacity Utilization  

CU = Demand/capacity*100 

So CU = D/C*100 = 2800units/365days/10000units * 100 = 0.08%. 

 

Throughput Dollar Days  

IDD = (Price - Cost)/Manufacturing stage time * MIN (demand, capacity) 

Manufacturing stage time = Production Throughput time (TPT) = 0.5day 

So IDD = (0.15€/unit – 0.1€/unit)/0.5day * 2800units/365days = 0.77€/day. 

 

Inventory Dollar Days  

Inventory dollar-days are the dollar-value of the inventory at hand multiplied by the 

time since the inventory entered the responsibility of the link.  

IDD = tiv * itr 

TIV = Totally Inventory Value = Average inventory in EUR  

ITR = Inventory Turn Rate 

So IDD= 0.91€ * 460.53days = 419.08€/day. 
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4.2. Report of graph and table view 

All the above mentioned steps focus on built the network construction. Next step we 

will depend on the base network construction to report of the related graphs and tables 

view. When we click on views > Graph view from the menu-bar, the drop-down menu 

list many model of view such as: Gantt, Inventory, Service, Total inventory values vs. 

service level, inventory and so on.  

 

4.2.1. Graph view 

Figure 34 shows the lead time view of the supply demand network by using the Gantt 

graph view. The Gantt graph can adjust different time periods on the network and 

available display the bottleneck of lead time through the entire material flow. User can 

select the relevant time period to check the network schedule, such as: shipping time, 

order backlog time, engineering lead time and production throughput time (TPT). From 

Figure 30 shows the time period from end of May to middle of July. The red color line 

display the products lead time to customers. The OEM customer has the longest lead 

time of 34.1days. The OEM customers’ located in Sweden, so the transport time very 

long and transport type as “ship”. Although the transport cost get lower than other type, 

but the long lead time will cause trouble in later stages. The factory cannot very quick 

to respond the customer uncertainty needed in the future. For that reason, the Barbie 

Doll Factory maybe thinking about other transport type to balance the transport cost 

and lead time, for example railway and air transport combines. 
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Figure 34. Gantt graph view. 

 

Figure 35 shows the over view of inventory amounts and uses different color to present 

the type of inventory. For example, the red color refers to the cycle stock inbound; the 

blue color refers to the safety stock inbound; the green color refers to the safety stock 

outbound; the yellow color refers to the cycle stock outbound. The figure shows the 

OEM customer (retailer) is quite high amount. For improvement, the user should 

reduce the high amount level to balance the network; means reduce the downstream 

inventory amount level to increase the upstream level.  
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Figure 35. Inventory view. 

 

Figure 36 shows the view of the inventory value and uses the curve describe the 

inventory holding cost level. The high inventory value level goes with high inventory 

holding cost level. In this figure the OEM customer (retailer located at Sweden) has the 

highest inventory value with the highest holding cost. For future improvement, user 

should reduce the highest inventory value to balance the whole network inventory 

value, at the same time the highest inventory holding cost get decrease.  
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Figure 36. Inventory value view. 

 

Figure 37 shows the service chart of Barbie Doll supply demand network. It is clearly 

shows the lowest service come from supplier of Doll hair which on time-to-delivery 

(OTD) lower than 70 percent. Maybe the 68.0% of OTD level is satisfaction for Doll 

hair supplier, but it will suffer unnecessary delay to the whole network. So the service 

chart can help user to analysis the network OTD and make the suitable decision to 

performance customer satisfaction. In case improvement, the OTD of Doll hair supplier 

is improve from 68.0% to 80.0% while the OTD of Doll clothes supplier is improve 

from 75.0% to 85.0%. 
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Figure 37. Service view. 

 

To balance the inventory cost and service level not easy for manager. When we 

improvement the serves level always with the increase of the inventory cost. Figure 38 

shows the curve describe the relationship between total inventory values and service 

level. User can through blow the curve to find the balance point that maintains a 

suitable service level without too higher inventory cost. For example, 2016.193€ of 

inventory cost can maintain 65% service level; while 2146.656€ inventory cost can 

maintain 90% service level. So the user can compare the two points, just increase 

130.463€ of inventory cost get the service level improvement from 65% to 90%. Even 

the Total inventory Value VS. Service Level graph view can draw the curve with 

different individual component, such as supplier, manufacturing, retail, and customer.  
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Figure 38. Total inventory value VS. Service level view. 

 

4.2.2. Table view 

Node table view offers us the current status of every node in the supply demand 

network, includes input and output data. When we select Views > node table view from 

the main menu-bar, a node table view appears show in table 2, While shift to output 

show in table 3. The table 2 displays all the input information of every node such as: 

label, product type, price, cost, OTD, lead time and so on. The table 3 list the calculate 

result of every node such as: lead time to customer, average inventory in units and EUR, 

cycle stock, safety stock, inventory turn rate and so on. We can define and modify the 

input data in the section of input from the node table view. 
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Table 2. Node table view with input data. 

 

 

Table 3. Node table view with output data. 

 

Transport table view shows the transportation status of every arrow in the supply 

demand network. When we select Views > Transport table view from the main 

menu-bar, a transport table view appears show in table 4, While shift to output show in 
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table 5. The table 4 displays the type, price, cost, lead time, transport frequency and etc. 

The table 5 shows calculate result such as: demand, average waiting time, order lead 

time and goods in transport. We can check all the input data of arrow or modify data in 

the section of input from the transport table view.  

 

 

Table 4. Transport table view with input data. 

 

 

Table 5. Transport table view with output data. 

 

Table 6 shows the result of financials analysis. Go to the main menu-bar, select Views > 

Financials can be displayed as below. 
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Table 6. Totally financials view. 

 

4.3. Improvement the base case 

ASDN provides the user with a variety of analysis tools that visualize the supply chain 

from multiple dimensions (Helo, 2006). The graphs and tables help the user to make 

suitable decision at strategy level. After the graphs and tables view of base case, next 

task is to improve it. Below subchapter shows how to reach the improvement result and 

optimize goal. ASDN practices applied to improve the supply demand networks with 

the decoupling point marked as a stock holding point.  

 

4.3.1. Modified the input data for improvement 

Any improvements or change within the base case could create new scenario, select 

Scenario > Add new scenario from the menu-bar. The new scenario named as Modified 

model and display on the main window as show below figure 39. For case improvement, 

there have three nodes and one arrow will get modified at the section of input. The three 

nodes include: Barbie Doll factory, Supplier of Doll hair and Doll clothes. One arrow of 

data belongs to the transport from Barbie Doll factory to OEM customer.  
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Figure 39. Modified Barbie Doll supply demand network. 

 

Barbie Doll factory modified the input data, improve the type from “MTS” to “ATO”, 

improve order backlog from “2.0days” to “1.0day”, and improve engineering lead time 

from “2.0days” to “1.0day”. the OTD of Doll hair supplier is improve from 68.0% to 

80.0% while the OTD of Doll clothes supplier is improve from 75.0% to 85.0%. The 

arrow of transport from the Barbie Doll factory to OEM customer, change the type from 

“ship” to “Rail”, price “7300.0€” increase to “15000.0€”, cost from “6800.0€” increase 

to “13500.0€”, transportation time reduce from “28.0days” to “12.0days”, transport 

frequency also reduce from “10.0days” to “7.0days”.  

 

Compare with figure 25, the lower left corner of figure 39 shows the output data have 

new result. Its information such as; order lead time for customer: 47.0days reduce to 

28.0days, average inventory in units: 127units reduce to 103units, average inventory in 

EUR: 2504€ reduce to 1764€, capacity constraint have same node: SOKOS (Finland). 
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After the modified, the new result of financial view compare with base case shown in 

table 7. The lead time to customer get shorter than base case from 17.82days reduce to 

9.85days, cycle time reduce from 47.0days to 28.0days, inventory turns increase from 

6.31turns/year to 7.74turns/year, inventory holding cost decrease from 250.43€ to 

176.44€.  

 

 

Table 7. After modified of financials view. 

 

4.3.2. Goal Seek function for improvement 

ASDN provides several spreadsheet models for logistic networks, with data covering 

different inputs and outputs throughout the network. The user may use Goal Seek 

functionality where new scenarios are created by setting objectives with regard to 

inventory level, lead-time and service level (Helo, Xiao & Jiao, 2006). Select Tools > 

Goal Seek from the main menu-bar, Goal Seek option appears show like figure 40. It 

used for decision making process such as, minimize inventory and order-decoupling 

points. Subject to some constrains such as, keep lead time short than, keep total 

inventory value less than and keep lead time to customer < Maximum order 

fulfillment time. Different decision making scenarios can be optimized by clicking on 

the button “Optimize” which is shown below too. 
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Figure 40. Goal seek. 

 

Click the button of optimize, then the ASDN tool start to calculate the optimal values 

through a series of build-in mathematical models (Petri, 2007) and the optimizing 

processing shows in figure 41. After the calculation done, click the button of create new 

scenario to add new scenario result on the main window.  

 

 

Figure 41. Optimizing process of Goal Seek function. 
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Next step we are renamed scenario as optimize of base case, select Scenario > Rename 

scenario from the menu-bar, click accept on the rename, the scenario of optimize model 

appears show in figure 42.  

 

 

Figure42. Scenario of optimize model. 

 

Go to the main menu-bar; select Views > Financials result displayed as below table. 

Table 8 shows the compare result of financials analysis between the base cases, 

modified remodel and optimize model.  

 

 

Table 8. Optimize of Financials view. 
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4.4. Save file and exit ASDN tool 

Finally user does not forget to save the file, click File > Save from the menu-bar, select 

the location where you want your file to save and give our file a name, click save. If we 

want to exit the ASDN tool, click File > Exit from the menu-bar to exit the ASDN.  

 

4.5. Results  

ASDN implementation has facilitated toy industrial to build the Barbie Doll products 

supply demand networks quickly and improvement responsiveness and inventory level 

with agility. It has given the operation managers more clear information visibility 

across the entire dispersed network. The final improved result will come from compare 

the analysis at two views. 

 

From the total network view, we are comparing the figure 25 and figure 39 of the lower 

left corner get the analysis results such as: 

 Order lead time for customer: reduce 19 days 

 Average inventory in units: reduce 24 units  

 Average inventory in EUR: reduce 740 €  

 

From compare base case and optimize model of Financials view show in table 7, we get 

the results such as: 

 Lead time to customer: reduce 7.97 days 

 Cycle time: reduce 19 days 

 Inventory turns: increased 1.43 turns / year 

 Inventory holding cost: reduce 73.99  
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4.6. Discussion  

We get know the software function and operation in this chapter when using ASDN to 

design and analysis an example of toy supply demand networks. ASDN as agile supply 

chain management software, which operation can quick to build supply demand 

networks and present clear visible analysis result, even improvement project of 

currently status. ASDN implementation in this case has improved responsiveness, 

delivery performance and agility, reduced inventory carrying and obsolescence costs.  

 

The major advantage of ASDN includes:  

1) Operation very easy and friendly for new user;  

2) Visible the network relation between supply and demand;  

3) The analysis through friendly graph interface and inventory models to user;  

4) Multiple scenarios display before and after improvement.  

 

But there still have some gaps when we are operate the ASDN software. The 

disadvantage of ASDN includes: 

1) ASDN software system only support open one XML document, we cannot open 

multi-xml document at same time. That means you cannot compare and analysis 

tow design models with one system; 

2) The Gantt graph display the time periods at horizontal abscissa have language error. 

The effect language of graph displays the same language with the computer 

windows system language. For example, the graph display x- axes with Chinese if 

the computer operation system with Chinese, while the problems shown at figure 30 

Gantt graph view (this problem appear basis on my laptop test); 

3) When Select Tools > Lot size calculator from the main menu-bar, a calculator 

window of optimize appears, all the text cannot show hold sentence with myself 

computer. The suspension points instead the long word and sentence. 



91 

5. SUMMARY AND CONCLUSIONS  

The summary and conclusions of the present study are presented in this chapter. There 

are two subchapters. In the first subchapter, the present study is summarized the study 

and answer the research problem. Conclusions are given in the second subchapter, in 

which the results in application of ASDN software and limitations of the study are 

given. 

 

5.1. Summary 

In general, this study focuses on application of the ASDN (Agile Supply Demand 

Networks) software to improvement toy logistics network. In more detail, the present 

research has given specific attention to agile supply chain management, demand 

supply chain management, demand response strategies and inventory models. The 

researcher worked as a development engineer with ASDN software and tasks were 

design an example of complex toy supply demand networks, improvement the toy 

industrial logistics network, optimize inventory value level, reduce lead time and 

inventory holding cost. The topic of the present study is stated as follows: agile 

supply demand networks approach to optimize inventory and reduce lead time. The 

research problem is how to use ASDN software to analyze and optimize current toy 

industrial logistics network? In order to resolve the research problem, four following 

objectives are discussed. And meanwhile, in order to summarize the whole study, the 

discussions of each objective are briefly presented and reviewed. 

 

The first objective is study agile supply chain management, demand supply chain 

management, demand response strategies and inventory models in order to increase 

basic understanding ASDN software. 
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To understand agile supply chain, we need to first clarify the meaning of agility. In brief, 

Agile means fast moving. The concept of Agility defines as ability to respond quickly 

and effectively to satisfy customers (Veeramain & Joshi, 1997). The concept of the 

agile supply chain is advocated as a new way forward for business networks to 

succeed in the highly changing and turbulent business environments. Christopher 

(2000) defines four key characteristics for agile supply chain, such as: 1) more demand 

driven rather than forecast-driven (market sensitive and responding to real demand); 2) 

share information between buyers and suppliers; 3) join product development and 

common system between buyers and suppliers; 4) network based with shared targets 

(create competing networks with committed and close buyers and suppliers 

relationships with final customers). Compare with traditional supply chain 

management (SCM), agile supply chain management (ASCM) can effectively or 

efficiently support a customer-driven and dynamically changing market. ASCM 

operation system is a network-based operation, which strategic inventory driven by 

demand.  

 

Demand supply chain management need to coordinate the demand and supply 

processes has been emphasized in the chain of organizations. It is includes demand 

chain management and supply chain management. The demand chain management 

(DCM) obtains a competitive advantage by providing superior customer value. The 

supply chain management (SCM) obtains a competitive advantage by providing 

comparable customer value at lower cost. In customer-centered marketing approach, 

the chain of organization need for DCM to be in charge of SCM, which means in 

environments with increasing diversity, in customer needs and requirements, so agile 

companies must rapidly adjust their supply to meet demand. 

 

A major problem in most supply chains is their limited visibility of real demand 
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(Christopher, 2000). So we presented with the decoupling point in different positions 

along the supply chain as a stock holding point, which in order to lower inventory 

levels and enhance customer service. Demand response strategies includes: 

make-to-stock (MTS), assemble-to-order (ATO), make-to-order (MTO) and 

engineer-to-order (ETO). The make-to-order (MTO) systems offer a high variety of 

customer-specific and typically, more expensive products, production planning focus 

on order execution; the make-to-stock (MTS) systems offer a low variety of 

producer-specified and typically, less expensive products, which focus on anticipating 

the demand (forecasting), and planning to meet the demand; the assemble-to-order 

(ATO) systems offer a high level of product variety to customers, while maintaining 

reasonable response times and costs, which focus on rapidly assembled from 

component inventories in response to customer orders; the engineer-to-order (ETO) 

systems offer high level of customization, high customers design, volume flexible, 

short cycle time, no inventory costs products, which focus on receiving customer 

requirement. 

 

Inventory model definition as mathematical equation or formula that helps a firm in 

determining the economic order quantity, and the frequency of ordering, to keep goods 

or service flowing to the customer without interruption or delay. So study inventory 

models for uncertain demand is necessary. We are consider several types of models to 

study, such as Supplier Lead Time, Internal Lead Time, Lead time To Customer, 

Service Level, Cycle Stock, Safety Stock, Inventory Value , Average Inventory, 

Inventory Turn Rate, Theory of Constraints (TOC), Inventory Dollar Days (IDD), 

Throughput Dollar Days (TDD), Order point system, Economic Order Quantity 

(EOQ) Model. We can understand the inventory calculation logic of ASDN software 

through inventory models study.  
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The second objective is study the definition and function modules of ASDN software 

in order to understanding application of ASDN tool. 

 

Agile Supply Demand Networks is software for analyzing and developing logistics 

networks. It is a network drawing tool for analyzing multi-site manufacturing and 

material flows, which can help managing global supply-demand networks to be more 

agile and time responsive, optimizing the level of inventory. It operates as an 

information platform, by which integrate with their customers and suppliers to quickly 

build supply demand networks. All the information, activities and decision are 

visualized, synchronized and optimized by ASDN system (Helo, Xiao & Jiao, 2006). 

 

The key functional modules in ASDN are modeling, optimization, analysis and report, 

interface, and database. Modeling module, which can help user building and 

configuring the supply chain model quickly and efficiently. Optimization module, 

which provided to optimize specified performance of supply demand network with a 

variety of build-in mathematical algorithms. Analysis and report module, which 

analyzes the supply demand network performance from different kinds of aspect and 

visualizes the result by a variety of geographic and tabular reports. Interface, which 

enables the users and other systems transform the data to ASDN and assess the 

concerned output information. Database module, which stores the data and 

information related to supply demand network, customer demand, supply ontology, etc.  

 

The third objective is use ASDN tool to design a complex toy supply demand 

networks and explain related inventory models calculation. 

 

ASDN is a free software for user to download and easy to set up. In this task, we are 

given a brief guideline to use the ASDN software. The first, we are design the network 

consists of eight elements: four suppliers, one manufacturer, one retailer, one sales 
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company and one end customer. The main supplier from China, assemble factory locate 

in China, the finish product ship to North Europe for sale. The second, we are through 

modeling module function to draw the supply chain nodes. Node is basic unit of a 

network, which represents suppliers, manufacturer, retailers and customers. We basic 

reverse engineering and networks by demand-drive mind to design the construction of 

network, so create the start node will come from customers, then manufacturer, the last 

is suppliers. The third, we are defined and modify the input data in the section of 

general, finance, manufacturing and inventory to each node. The finally, we are link 

the nodes with transport arrows and defined and modify input data in the section of 

general and number to each arrow. After the modeling, the lower left corner shows the 

output data of total networks based on our input data to each node and arrow in the 

network. Its information such as; order lead time for customer: 47.0, average inventory 

in units: 127, average inventory in EUR: 2504, capacity constraint node: SOKOS 

(Finland). 

 

In the output section of each node, we are get detail information from Manufacturing, 

Inventory, In (Out) bound and TOC to each node. The related inventory models 

calculation not only display from the windows of ASDN software, but also show side 

by side coming from equations by hand calculate. The related type of models 

calculation, such as: Supplier Lead Time, Internal Lead Time, Lead time To 

Customer, Service Level, Cycle Stock, Safety Stock, Inventory Value , Average 

Inventory, Inventory Turn Rate, Theory of Constraints (TOC), Capacity Utilization, 

Inventory Dollar Days (IDD), Throughput Dollar Days (TDD). After all calculations, 

we are not only explaining how to get the numbers of output data, but also the 

equation by hand calculates obtain same results with ASDN calculation logic. So it is 

proved the software system has correct calculation logic. ASDN as logistics analysis 

tool can be trust to use for analyzing and developing the complex toy logistics 

networks.  
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The fourth objective is use ASDN tool to create graph interface to analysis the 

complex toy supply demand networks, and optimize the analysis results. 

 

We are use function of analysis and report module to draw the related graphs and 

tables view, which present toy supply demand networks in a holistic view and examine 

issues such as: Gantt graph view, Inventory view, Inventory value view, Service view, 

Total inventory value VS. Service level view, Node table view, Transport table view, 

and Totally Financials view. 

 

Gantt graph view can show the lead time over view of the network, which can adjust 

different time periods on the network and available display the bottleneck of lead time, 

which assistant user select the relevant time period to check the network schedule. 

Inventory view display all the components’ inventory level, which can help user find 

and reduce the high amount level to balance the network. Inventory value view is 

describing the inventory holding cost level, which can help user find and reduce the 

highest inventory value to balance the whole network inventory value. Service view 

shows all the nodes’ service level, which can help user to monitor the service level 

and protect the service quality. Total inventory value VS. Service level view can draw 

the curve with different individual component, such as supplier, manufacturing, retail, 

and customer. To balance the inventory cost and service level not easy for manager. 

When we improvement the services level always with the increase of the inventory cost. 

Node table view displays the input/output information of all nodes; we can define and 

modify the input/output data in the section of input/output from the node table view. 

Transport table view shows the transportation status of all arrows in the toy supply 

demand networks; we can define and modify the input/output data in the section of 

input/output from the transport table view. Totally Financials view shows the result of 

financials analysis.  
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We through two steps to optimize the result: the first step is modified the input data 

for some nodes, such as service level, lead time, demand response strategies, type of 

transportation and transportation fee; the second step is use the function of Goal Seek 

continue to optimize the modified network. Compare base case and after remodel of 

Financials view after the calculation done, we get the results such as: 

 Lead time to customer: reduce 7.97 days 

 Cycle time: reduce 19 days 

 Inventory turns: increased 1.43 turns / year 

 Inventory holding cost: reduce 73.99 € 

 

5.2. Conclusions 

In this thesis, we use ASDN software to model, analyze and optimize the toy supply 

demand networks. Performance measures such cost, inventory, value-add, lead time 

and throughput in the network are analyzed and optimized through the network. We 

are through performance four objectives to resolve the research problem: how to use 

ASDN software to analyze and optimize current toy industrial logistics network? 

Application of ASDN software not only help toy industrial to fix the gap of inventory 

problem, improvement the logistics network, optimize inventory value level; but also 

through integrated retailers, distributors, manufacturers and suppliers to reduce the lead 

time to customers and inventory holding cost. 

 

ASDN software as IT platform, which support to information exchange between the 

supplier and customer, thus it can easily make flexible schedule and inventory 

allocation policy according to received demand information. So it can resolve the 

problem of high levels inventory for both sellers and manufacturers. ASDN software 
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as analysis tool supports configuration flexibility, view flexibility and algorithm 

flexibility. Configuration flexibility is the ability to configure an alternative supply 

chain scenario based on the main supply demand network and get the analysis results 

quickly. View flexibility refers to diversified reports that analyze supply chain 

scenarios from different types of aspects like inventory amount, value-added, service 

level, etc. Algorithm flexibility includes optimization algorithm selection in the lot size 

calculator which provides a variety of algorithms that are suitable for specific 

production circumstance (Helo, Xiao & Jiao, 2006). ASDN as strategy tool of agile 

supply chain management can get guaranteed lead-time from supplier, which provides 

support to the manager in making improved business strategy decisions that lead to 

maximizing customer service and profits by capitalizing on the added-value of the 

entire supply chain (Helo, 2006).  

 

In general, the major advantage of application ASDN software includes: Firstly, the 

whole operation very easy and friendly for new user. Secondly, the visible the network 

relation between supply point and demand point. Thirdly, the analysis through friendly 

graphs interface and inventory models display to user. Fourthly, multiple scenarios 

separate to display basic networks and after improvement networks.  

 

The research limitations discuss at below. Firstly, the network view cannot connect 

with Google map is one of the limitation and therefore the map function won’t support 

re-evaluate the supply demand strategic plan and pinpoint accuracy, for instance plant 

location and physical distribution structure. Secondly, design the simple simulate 

example aim to show the application process of ASND, so the numerical result not 

good consult for real complex supply demand networks analysis. Thirdly, the simple 

simulate example was mainly working for the internal system, so integrate the external 

information system like ERP will not show in this paper. Lastly but not the least, 

ASDN software can analyze variants for products. It is means ASDN tool can analyze 
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several families of Barbie Doll Models at same times. Because this thesis only 

considers one simple Barbie Doll product supply demand networks, so this function 

also not show in this paper. 
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APPENDIX  SEVICE LEVEL AND SEVICE FACTOR 

Service Level    Service Factor   Service Level         Service Factor 

50.00%             0.00         90.00%                1.28 

55.00%             0.13         91.00%                1.34 

60.00%             0.25         92.00%                1.41 

65.00%             0.39         93.00%                1.48 

70.00%             0.52         94.00%                1.55 

75.00%             0.67         95.00%                1.64 

80.00%             0.84         96.00%                1.75 

81.00%             0.88         97.00%                1.88 

82.00%             0.92         98.00%                2.05 

83.00%             0.95         99.00%                2.33 

84.00%             0.99         99.50%                2.58 

85.00%             1.04         99.60%                2.65 

86.00%             1.08         99.70%                2.75 

87.00%             1.13         99.80%                2.88 

88.00%             1.17         99.90%                3.09 

89.00%             1.23         99.99%                3.72 

 

Service level 
Desired service level expressed as a percentage. 
 
Service factor 
Factor used as a multiplier with the Standard Deviation to calculate a specific quantity 
to meet the specified service level. I have included a service factor table below or you 
can use Excel function NORMSINV to convert service level percentage to service 
factor. 

 

Source: http://www.inventoryops.com/safety_stock.htm 

http://www.inventoryops.com/safety_stock.htm�
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